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RINGKASAN 
 

Dalam era digital saat ini, teknologi berperan penting dalam berbagai bidang, termasuk 

pendidikan. Teknologi mempermudah penyelesaian tugas-tugas administratif, yang sangat 

penting bagi guru di Taman Kanak-Kanak (TK) seperti di TK Al-Hikmah. Guru-guru di TK 

Al-Hikmah menghadapi beragam tugas administratif seperti menyusun rencana pembelajaran, 

membuat laporan perkembangan siswa, dan menulis surat untuk orang tua, yang seringkali 

mengurangi waktu mereka untuk fokus pada pengajaran. 

Microsoft Word adalah perangkat lunak yang dapat membantu meningkatkan efisiensi 

kerja guru-guru TK Al-Hikmah. Dengan berbagai fitur seperti template dokumen yang 

memudahkan pembuatan dokumen standar, guru dapat menghemat waktu dan tenaga dalam 

menyusun dokumen. Fitur ini juga membantu menghasilkan dokumen yang rapi dan 

profesional. 

Dengan memanfaatkan Microsoft Word, guru-guru TK Al-Hikmah diharapkan dapat 

menyelesaikan tugas administratif dengan lebih cepat dan mudah, sehingga memiliki lebih 

banyak waktu untuk fokus pada pengajaran dan interaksi dengan siswa. Penggunaan Microsoft 

Word diharapkan dapat meningkatkan efisiensi kerja dan kualitas administrasi, mendukung 

guru dalam menciptakan lingkungan belajar yang lebih baik bagi anak-anak. 

  



KATA PENGANTAR 
 

Puji syukur kami panjatkan ke hadirat Allah SWT atas segala rahmat dan karunia-

Nya, sehingga makalah berjudul “pelatihan pengenalan microsoft word pada guru tk al-

hikmah” ini dapat terselesaikan. 

Makalah ini disusun untuk memberikan pemahaman tentang pentingnya penggunaan 

teknologi, khususnya Microsoft Word, dalam mendukung tugas-tugas administrasi guru agar 

lebih efisien. 

Kami mengucapkan terima kasih kepada semua pihak yang telah membantu dalam 

proses penyusunan makalah ini. Semoga makalah ini dapat bermanfaat bagi para pembaca 

dan dunia pendidikan. 
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BAB I  

PENDAHULUAN 

 

1.1. Latar Belakang 

Dalam era globalisasi, perkembangan teknologi informasi dan komunikasi telah 

mengalami kemajuan pesat, termasuk di bidang pendidikan (Salsabila et al., 2021; Azizah et 

al., 2021). Teknologi berperan penting dalam membantu menyelesaikan tugas-tugas 

administratif dan pengelolaan dokumen. Di lingkungan pendidikan, guru tidak hanya bertugas 

mengajar, tetapi juga harus mampu mengelola berbagai tugas administrasi dengan efisien. 

Teknologi seperti Microsoft Word telah menjadi alat yang esensial dalam membantu guru 

menyusun dokumen penting, mulai dari rencana pembelajaran hingga laporan perkembangan 

siswa, dengan lebih cepat dan terstruktur. Menurut Pratama dan Lestari (2020), penggunaan 

teknologi dalam pendidikan mampu mempercepat proses administrasi yang sebelumnya 

memakan waktu lebih lama. 

Namun, di banyak sekolah, termasuk TK Al-Hikmah, guru-guru masih mengandalkan 

metode tradisional dalam menyelesaikan pekerjaan administrasi. Mereka sering kali harus 

menulis laporan dan surat secara manual, menggunakan kertas dan pulpen atau mengetik 

dokumen satu per satu tanpa bantuan template atau format yang sudah terstandar. Menurut 

Suryani dan Wahyudi (2019), metode ini tidak hanya memakan waktu lebih lama, tetapi juga 

berisiko mengakibatkan ketidakseragaman format dokumen, yang berpengaruh terhadap 

profesionalitas laporan yang dihasilkan. 

Jika metode tradisional ini terus digunakan, sejumlah masalah dapat timbul. Guru akan 

semakin kewalahan dalam menyelesaikan tugas administratif yang banyak dan bervariasi, 

sehingga waktu mereka untuk fokus pada pengajaran menjadi semakin terbatas. Selain itu, 

dokumen yang dibuat secara manual rentan terhadap kesalahan, baik dalam penulisan maupun 

format, yang dapat menurunkan kualitas dokumen administrasi sekolah (Putri & Nugroho, 

2020). Akibatnya, hal ini berpotensi mengganggu proses kerja sekolah secara keseluruhan, 

terutama dalam hal efektivitas komunikasi dan penyajian informasi yang akurat. 

Untuk mengatasi masalah ini, pemanfaatan Microsoft Word menjadi solusi yang sangat 

efektif. Microsoft Word menawarkan berbagai fitur yang dapat mempermudah pembuatan 

dokumen standar seperti surat, laporan, dan rencana pembelajaran melalui penggunaan 

template yang siap pakai. Dengan memanfaatkan template, guru dapat menghemat waktu dan 



energi karena tidak perlu memulai dari awal. Selain itu, dokumen yang dihasilkan akan lebih 

terstruktur, rapi, dan profesional (Kusuma & Sari, 2020). Dengan demikian, Microsoft Word 

memungkinkan guru untuk lebih efisien dalam menyelesaikan tugas administratif, sehingga 

mereka bisa lebih fokus pada pengajaran dan interaksi dengan siswa (Susanto & Rachman, 

2021). 

1.2.  Analisis Permasalahan 

Masalah utama yang dihadapi di TK Al-Hikmah adalah beban administratif yang berat 

yang dihadapi oleh para guru. Selain tugas utama mereka untuk mengajar, guru-guru harus 

menyelesaikan berbagai tugas administratif seperti menyusun rencana pembelajaran, membuat 

laporan perkembangan siswa, menulis surat kepada orang tua, dan menyusun jadwal kegiatan. 

Beban administratif yang tinggi ini seringkali mengurangi waktu dan fokus mereka dari tugas 

utama, yaitu mengajar dan berinteraksi dengan siswa. 

Keterbatasan waktu yang disebabkan oleh banyaknya tugas administratif berdampak pada 

kualitas pengajaran yang dapat diberikan kepada siswa. Guru-guru seringkali tidak memiliki 

cukup waktu untuk berfokus pada kegiatan edukatif yang lebih bermanfaat, karena mereka 

harus menghabiskan waktu untuk menyusun dokumen manual. Proses pembuatan dokumen 

yang tidak terstandarisasi atau manual juga dapat mengakibatkan dokumen yang kurang rapi 

dan tidak profesional, yang berpotensi mempengaruhi kualitas administrasi sekolah dan 

komunikasi dengan orang tua serta pihak sekolah. 

Selain itu, meskipun Microsoft Word memiliki berbagai fitur yang dapat meningkatkan 

efisiensi dalam menyelesaikan tugas administratif, belum semua guru di TK Al-Hikmah 

memanfaatkan teknologi ini secara maksimal. Banyak fitur canggih yang dapat membantu 

mengurangi beban administratif belum digunakan secara optimal. Keterampilan teknologi yang 

terbatas di kalangan guru juga menjadi kendala, karena tidak semua guru memiliki pengetahuan 

atau keterampilan yang memadai dalam menggunakan fitur-fitur Microsoft Word secara 

efektif. 

Untuk mengatasi masalah ini, penting untuk mengevaluasi dan mengimplementasikan 

solusi yang dapat membantu guru-guru di TK Al-Hikmah dalam memanfaatkan Microsoft 

Word dengan lebih baik. Melalui pelatihan penggunaan teknologi, adopsi fitur-fitur efisien, 

dan manajemen waktu yang lebih baik, diharapkan efisiensi kerja dapat meningkat. Dengan 

demikian, guru-guru dapat lebih fokus pada pengajaran dan pengembangan siswa, serta 

meningkatkan kualitas administrasi dan komunikasi di lingkungan sekolah. 



 

1.3.  Solusi Permasalahan 

Untuk mengatasi masalah beban administratif di TK Al-Hikmah dan meningkatkan 

efisiensi kerja guru, beberapa solusi dapat diterapkan. Pertama, penting untuk mengadakan 

pelatihan teknologi yang akan memperkenalkan guru-guru pada fitur-fitur Microsoft Word 

yang dapat mempermudah tugas administratif mereka. Pelatihan ini dapat mencakup 

penggunaan template standar untuk dokumen seperti rencana pembelajaran dan laporan 

perkembangan siswa, yang akan menghemat waktu dan memastikan format dokumen yang 

konsisten. Selain itu, fitur otomatisasi seperti AutoText dan Quick Parts dapat digunakan untuk 

menyimpan dan menyisipkan teks yang sering digunakan, sehingga mengurangi pengulangan 

pekerjaan. Memanfaatkan layanan cloud seperti OneDrive juga penting untuk menyimpan, 

berbagi, dan berkolaborasi pada dokumen secara efisien. Dengan menerapkan solusi-solusi ini, 

diharapkan guru-guru dapat mengurangi beban administratif, meningkatkan kualitas 

administrasi, dan lebih fokus pada pengajaran dan interaksi dengan siswa. 

 

 

1.4. Tujuan Pengabdian 

Tujuan dari pengabdian ini adalah untuk untuk memberikan pelatihan pemanfaatan 

teknologi, khususnya Microsoft Word untuk menyelesaikan tugas administratif sehari-hari. 

Dengan memberikan pelatihan yang tepat, diharapkan para guru dapat memaksimalkan 

penggunaan fitur-fitur yang ditawarkan oleh Microsoft Word, seperti shortcut, template, dan 

otomatisasi teks. Tujuan akhir dari pengabdian ini adalah untuk mengurangi beban 

administratif para guru, sehingga mereka dapat lebih fokus pada tugas utama mereka dalam 

mendidik dan berinteraksi dengan siswa, menciptakan lingkungan belajar yang lebih efektif 

dan produktif bagi anak-anak di TK Al-Hikmah. 

  



BAB II  

METODE PELAKSANAAN 

 

2.1 . Tinjauan Iptek 

Salah satu komponen utama di dalam paket Microsoft Office adalah Microsoft Word, yang 

merupakan perangkat lunak pengolah kata (Sinaga, Nurhadiah, Hasibuan, Salsabila, & 

Nurbaiti, 2022). Microsoft Word memberikan manfaat yang signifikan di dunia teknologi yang 

terus berkembang, baik dalam konteks kegiatan produktif maupun edukatif. Penggunaan 

Microsoft Word telah meresap di hampir semua sektor pekerjaan masyarakat (Bakhri, 2022), 

terutama dalam hal pengelolaan dokumen sehari-hari. Salah satu kekuatan utama Microsoft 

Word adalah keberadaan berbagai fitur, baik fitur dasar yang sudah dikenal luas maupun fitur 

yang jarang diketahui oleh pengguna amatir. Fitur dasar seperti pemformatan teks, penomoran 

halaman, pemeriksaan ejaan otomatis, dan pengaturan paragraf adalah beberapa contoh yang 

sering digunakan oleh hampir setiap pengguna. Dengan fitur-fitur ini, seseorang dapat dengan 

mudah membuat dokumen yang rapi dan terstruktur, tanpa harus memikirkan banyak detail 

teknis. Misalnya, pengguna dapat dengan cepat mengatur font, ukuran huruf, margin halaman, 

dan memeriksa tata bahasa secara otomatis, yang membuat proses penulisan menjadi jauh lebih 

efisien dan nyaman. 

Selain itu, fitur pengaturan gaya (styles) juga dapat digunakan untuk menyelaraskan 

format dokumen dengan standar tertentu secara otomatis, yang jarang diketahui oleh pengguna 

pemula. Pengaturan ini memungkinkan perubahan format dilakukan dengan sekali klik, tanpa 

harus mengubah setiap bagian dokumen satu per satu. Pengguna amatir mungkin juga belum 

familiar dengan kemampuan Microsoft Word dalam membuat tabel kompleks, grafik, dan 

bagan yang secara visual membantu mempresentasikan data atau informasi dengan lebih jelas. 

Ditambah lagi, penggunaan templat yang sudah tersedia dapat sangat membantu pengguna 

yang perlu membuat dokumen tertentu dengan cepat, tanpa harus memulai dari awal. 

Dengan memanfaatkan baik fitur dasar maupun fitur yang lebih canggih, pengguna dapat 

bekerja dengan lebih efisien dan efektif. Pemahaman yang lebih baik tentang kemampuan 

Word, termasuk fitur yang jarang dieksplorasi oleh pengguna amatir, dapat sangat 

meningkatkan produktivitas dan kualitas pekerjaan. Pada akhirnya, Microsoft Word 

menawarkan lebih dari sekadar pengolah kata; microsoft word memberikan solusi yang 



lengkap untuk menyederhanakan proses pembuatan dokumen, mengurangi waktu yang 

digunakan untuk tugas-tugas berulang, dan meningkatkan profesionalisme dalam hasil akhir. 

 

2.2.  Kerangka Kerja 

 

Observasi Observasi aktivitas guru pada saat 

pembelajaran dan kegiatan administrasi 

 

Analisis Kegiatan berjalan dengan normal, guru 

menggunakan microsoft office untuk 

melakukan pekerjaan administratif dan 

melakukan pembelajaran seperti biasa 

 

Masalah Para guru kurang memanfaatkan fitur yang 

tersedia pada microsoft office dan 

cenderung melakukannya secara manual. 

Sehingga kegiatan yang seharusnya bisa 

selesai lebih cepat, jadi lebih lama. 

 

Pembelajaran biasa ( face to face ) hanya 

bisa terjadi jika guru dan murid hadir 

ditempat yang sama 

Solusi Pelatihan microsoft word dan excel demi 

meningkatkan efisiensi waktu saat 

melakukan kegiatan administratif 

 

Improvisasi pembalajaran inovatif 

menggunakan microsoft power point 

dengan bantuan orang tua 

Evaluasi dan monitoring Evaluasi hasil pelatihan secara berkala 

dalam beberapa hari, karena pemanfaatan 

hal baru dapat membebani individu atau 

bahkan menurunkan performa hasil kerja, 

maka evaluasi dilakukan secara berkala 

dalam beberapa hari 

Kesimpulan Penarikan kesimpulan dinilai dari 

pemahaman dan penerapan guru terhadap 

materi pelatihan  
Table 1 Kerangka Kerja 

Di TK Al-Hikmah, kegiatan administratif guru masih dilakukan menggunakan metode 

manual tanpa memanfaatkan fitur Microsoft Word. Dalam hal ini, meskipun penggunaan 

komputer dan perangkat lunak seperti Microsoft Word tersedia, guru-guru belum 

memanfaatkan fitur-fitur tersebut secara optimal. Sebagai gantinya, mereka menggunakan 

metode manual berbasis komputer, seperti mengetik dokumen menggunakan aplikasi pengolah 



kata dasar yang tidak memanfaatkan template, gaya, atau fitur otomatis lainnya yang 

disediakan oleh Microsoft Word. 

Secara keseluruhan, meskipun perangkat keras dan perangkat lunak dasar tersedia, 

belum adanya pemanfaatan fitur Microsoft Word mengakibatkan proses administratif di TK 

Al-Hikmah menjadi lebih lambat dan kurang efisien. Guru-guru harus menghabiskan lebih 

banyak waktu untuk menyelesaikan tugas administratif yang seharusnya bisa dipercepat 

dengan menggunakan fitur-fitur digital yang ada. 

Dalam pelatihan, materi yang dipilih difokuskan pada fitur-fitur sederhana dan mudah 

diingat untuk memastikan bahwa guru-guru di TK Al-Hikmah dapat dengan cepat 

mengimplementasikannya dalam pekerjaan sehari-hari mereka. Fokus utama adalah pada 

penggunaan shortcut keyboard dan fungsi dasar Microsoft Word yang sering digunakan, seperti 

copy-paste, format teks, dan pengaturan margin. Dengan mengajarkan shortcut yang 

mempermudah navigasi dan pengeditan dokumen, pelatihan ini bertujuan untuk meningkatkan 

efisiensi kerja dan mengurangi waktu yang dihabiskan untuk tugas administratif. 

Selain itu, materi pelatihan dirancang untuk menyajikan informasi dengan cara yang 

mudah dipahami dan diterapkan. Panduan pelatihan mencakup langkah-langkah praktis dan 

contoh nyata yang relevan dengan pekerjaan guru, sehingga mereka dapat langsung 

mempraktikannya. Dengan memberikan tips dan trik yang sederhana namun efektif, pelatihan 

ini membantu guru-guru untuk tidak hanya memahami, tetapi juga mengingat cara 

menggunakan fitur-fitur tersebut dalam rutinitas administratif mereka sehari-hari. Pendekatan 

ini memastikan bahwa teknologi dapat digunakan secara maksimal tanpa menambah beban 

belajar yang signifikan. 

Para guru menunjukkan motivasi yang tinggi selama pelatihan, dengan antusiasme 

yang jelas terlihat dalam setiap sesi. Mereka aktif berpartisipasi, menunjukkan minat yang 

besar terhadap materi yang disampaikan, dan dengan cepat mengaplikasikan fitur-fitur baru 

yang dipelajari dalam praktik. Keinginan mereka untuk meningkatkan keterampilan dan 

efisiensi administratif tercermin dalam semangat mereka untuk memahami serta 

menggunakan teknologi secara lebih efektif. Motivasi ini tidak hanya meningkatkan kualitas 

pelatihan, tetapi juga berpotensi membawa dampak positif yang signifikan terhadap efisiensi 

kerja mereka di TK Al-Hikmah. 

 



2.3.  Indikator  

Karena salah satu tujuan utama dari pelatihan adalah memastikan para guru mampu 

mengimplementasikan keterampilan yang telah mereka pelajari secara langsung, evaluasi dan 

monitoring dilakukan dengan cermat. Proses ini dirancang untuk memastikan bahwa setiap 

guru tidak hanya memahami teori penggunaan fitur Microsoft Word, tetapi juga dapat 

mengaplikasikannya dalam tugas-tugas administratif sehari-hari. Dengan demikian, 

monitoring dilakukan secara intensif selama satu hari penuh, di mana para guru dipantau saat 

mereka menyusun dokumen, mengatur jadwal, dan mengelola laporan perkembangan siswa 

menggunakan teknik yang baru dipelajari. 

Mahasiswa yang bertugas dalam proses evaluasi ikut berpartisipasi secara langsung dalam 

kegiatan administratif di sekolah. Mahasiswa mendampingi para guru, memberikan bantuan 

bila diperlukan, serta mengamati cara guru menerapkan fitur-fitur Microsoft Word yang telah 

diajarkan selama pelatihan. Dalam situasi ini, mahasiswa bertindak sebagai pendukung teknis 

yang siap membantu jika guru mengalami kesulitan teknis atau memerlukan penjelasan lebih 

lanjut tentang fitur tertentu. Pendekatan ini memastikan bahwa pelatihan tidak hanya berakhir 

pada teori, tetapi benar-benar diimplementasikan dengan baik dalam konteks pekerjaan nyata. 

Selama proses evaluasi, mahasiswa juga mengumpulkan data terkait efektivitas pelatihan, 

seperti kecepatan penyelesaian tugas dan tingkat pemahaman guru dalam menggunakan 

Microsoft Word. Setelah satu hari penuh pelaksanaan, mahasiswa bersama tim pelatih akan 

melakukan diskusi dengan para guru untuk memberikan umpan balik serta saran yang dapat 

meningkatkan efektivitas penggunaan teknologi dalam pekerjaan mereka. Dengan adanya 

evaluasi ini, pelatihan tidak hanya diukur berdasarkan keberhasilan penyampaian materi, tetapi 

juga pada kemampuan guru untuk mengintegrasikan teknologi ke dalam rutinitas administratif 

mereka secara berkelanjutan. 

  



BAB III  

PELAKSANAAN DAN HASIL 

 

3.1  Pelaksanaan Pengabdian 

 

Pengabdian ini dilaksanakan selama dua minggu dengan tujuan untuk meningkatkan 

keterampilan guru-guru TK Al-Hikmah dalam menggunakan Microsoft Word secara efektif 

untuk mendukung tugas-tugas administratif mereka. Selama periode tersebut, berbagai sesi 

pelatihan dan evaluasi dilaksanakan untuk memastikan setiap guru tidak hanya memahami 

materi yang disampaikan, tetapi juga mampu mengimplementasikannya dalam pekerjaan 

sehari-hari. Pengabdian ini dirancang dengan jadwal yang cukup fleksibel, memungkinkan 

guru untuk tetap melaksanakan tugas utama mereka sambil mengikuti pelatihan dengan baik. 

Fokus utama pengabdian adalah membangun keterampilan yang praktis dan langsung dapat 

digunakan oleh para guru, sehingga mereka dapat merasakan manfaat nyata dari teknologi yang 

mereka pelajari. 

Pelatihan dilakukan selama tiga jam per sesi, dengan materi yang disusun secara sistematis 

agar mudah dipahami dan diterapkan. Setiap sesi mencakup pengenalan fitur-fitur dasar 

Microsoft Word seperti penggunaan template, pengaturan gaya, dan penggunaan shortcut untuk 

mempercepat proses pengelolaan dokumen. Dalam setiap sesi pelatihan, guru-guru tidak hanya 

mendengarkan penjelasan teoretis, tetapi juga diberi kesempatan untuk berlatih langsung 

dengan bimbingan dari instruktur dan mahasiswa. Tujuannya adalah agar mereka dapat 

memahami dan mengingat cara menggunakan fitur-fitur tersebut secara efektif dalam waktu 

yang relatif singkat. 

Setelah setiap sesi pelatihan, dilakukan evaluasi dan monitoring selama empat jam. Proses 

ini dirancang untuk mengukur sejauh mana para guru mampu menerapkan apa yang telah 

mereka pelajari dalam tugas administratif sehari-hari. Mahasiswa berpartisipasi secara aktif 

dalam proses ini dengan mendampingi guru saat mereka mengerjakan tugas seperti menyusun 

rencana pembelajaran, membuat laporan perkembangan siswa, dan menyiapkan surat-surat 

resmi. Monitoring ini memungkinkan para guru untuk segera mendapatkan umpan balik dan 

dukungan jika menghadapi kesulitan, serta memberikan kesempatan bagi mahasiswa untuk 

melihat langsung bagaimana implementasi keterampilan teknologi dalam konteks kerja nyata. 

 



Tabel Kegiatan 

Hari 1 (30 September 2024 - Senin): Pembukaan dan Pengenalan Program 

 

08:00 - 09:00   Kedatangan peserta dan persiapan awal 

09:00 - 10:00   Pembukaan resmi oleh pihak sekolah dan 

perkenalan program PMKM oleh pelaksana 

10:00 - 11:00   Penjelasan tujuan, manfaat, dan jadwal 

kegiatan 

11:00 - 12:00   Diskusi awal dengan guru untuk 

memahami tingkat pemahaman dan 

kebutuhan terkait penggunaan Microsoft 

Office 

12:00 - 13:00   Istirahat dan makan siang 

13:00 - 14:00   Observasi awal untuk memahami cara kerja 

dan aktivitas guru dalam tugas administratif 
Table 2Kegiatan hari ke 1 senin 

Hari 2 (1 Oktober 2024 - Selasa): Pelatihan Microsoft Word - Dasar 

08:00 - 09:00   Persiapan dan briefing 

09:00 - 12:00   Pelatihan Microsoft Word (Dasar): 

Membuat dokumen, pengaturan format teks 

dan paragraf, pembuatan tabel sederhana 

12:00 - 13:00   Istirahat dan makan siang 

13:00 - 14:00   Sesi tanya jawab dan praktik langsung, 

penugasan membuat dokumen sederhana 

untuk administrasi kelas 
Table 3 kegiatan Hari ke 2 selasa 

Materi pelatihan hari selasa 

• Pengenalan Microsoft Word 

• Membuat dan Menyimpan Dokumen 

• Pengaturan Format Teks Dasar 

• Membuat dan Mengatur Tabel Sederhana 

• Pengaturan Tata Letak Halaman 

• Praktik Membuat Dokumen Sederhana 

 

Hari 3 (2 Oktober 2024 - Rabu): Observasi Microsoft Word dan Pelatihan Microsoft Word - 

Lanjutan 

08:00 - 09:00   Observasi penggunaan Microsoft Word 

(mengamati guru saat menyelesaikan tugas 

administratif menggunakan Word) 

09:00 - 12:00   Pelatihan Microsoft Word (Lanjutan): 

Menambahkan header dan footer, membuat 



template dokumen, dan menyimpan 

dokumen ke dalam format PDF 

12:00 - 13:00   Istirahat dan makan siang 

13:00 - 14:00   Latihan praktik dengan pembuatan 

dokumen laporan sederhana 
Table 4 kegiatan hari ke 3 rabu 

Materi pelatihan hari rabu 

• Review Pelatihan Hari Sebelumnya 

• Mengatur Header, Footer, dan Nomor Halaman 

• Membuat Template Dokumen Standar Sekolah 

• Menyisipkan Objek dan Grafik 

• Menggunakan Mail Merge untuk Surat Massal 

• Latihan Mandiri Membuat Dokumen Lanjutan 

 

Hari 4 (3 Oktober 2024 - Kamis): Pelatihan Microsoft Excel - Dasar 

08:00 - 09:00   Persiapan dan briefing pelatihan 

09:00 - 12:00   Pelatihan Microsoft Excel (Dasar): 

Memasukkan data ke dalam spreadsheet, 

pengaturan format sel, dan penggunaan 

fungsi dasar seperti SUM dan AVERAGE 

12:00 - 13:00   Istirahat dan makan siang 

13:00 - 14:00   Sesi praktik, penugasan membuat tabel data 

siswa 
Table 5 kegiatan hari ke 4 kamis 

Materi pelatihan hari kamis 

• Review Pelatihan Sebelumnya 

• Memasukkan Data ke dalam Excel 

• Mengatur Format Sel 

• Penggunaan Formula Dasar 

• Membuat Tabel Sederhana 

 

Hari 5 (4 Oktober 2024 - Jumat): Observasi Microsoft Excel dan Pelatihan Microsoft Excel - 

Lanjutan 

08:00 - 09:00   Observasi penggunaan Microsoft Excel 

(mengamati penggunaan fungsi dasar untuk 

tugas administratif) 

09:00 - 11:30   Pelatihan Microsoft Excel (Lanjutan): 

Penggunaan rumus IF, VLOOKUP, serta 

pembuatan grafik sederhana untuk analisis 

data 

11:30 - 13:00   Istirahat dan makan siang 



13:00 - 14:00   Latihan pembuatan data rekapitulasi 

sederhana menggunakan Excel 
Table 6 kegiatan hari ke 5 jumat 

Materi pelatihan hari jumat 

• Review Pelatihan Sebelumnya 

• Fungsi dan Formula Lanjutan 

• Mengatur dan Memformat Data 

• Mengatur dan Memformat Data 

• Membuat Grafik untuk Visualisasi Data 

• Latihan Mandiri Membuat Tabel dan Grafik 

 

Hari 6 (5 Oktober 2024 - Sabtu): Pelatihan Microsoft PowerPoint - Dasar 

08:00 - 09:00   Persiapan dan briefing pelatihan 

09:00 - 12:00   Pelatihan Microsoft PowerPoint (Dasar): 

Membuat slide presentasi, tata letak dasar, 

dan pengaturan teks serta gambar 

12:00 - 13:00   Istirahat dan makan siang 

13:00 - 14:00   Sesi praktik, penugasan membuat slide 

sederhana untuk pembelajaran kelas 
Table 7 kegiatan hari ke 6 sabtu 

Materi pelatihan hari sabtu 

• Pengenalan Microsoft PowerPoint 

• Membuat Presentasi Baru 

• Menambahkan Konten ke Slide 

• Mengatur Transisi dan Animasi 

• Praktik Membuat Presentasi Sederhana 

Hari 7 (7 Oktober 2024 - Senin): Evaluasi, Diskusi Hasil Pelatihan 

08:00 - 10:00   Evaluasi keterampilan guru dalam 

penggunaan Microsoft Word, Excel, dan 

PowerPoint (latihan singkat dalam setiap 

aplikasi) 

10:00 - 12:00   Diskusi mengenai hasil pelatihan, area yang 

perlu ditingkatkan, serta tantangan yang 

dihadapi selama pelatihan 

12:00 - 13:00   Istirahat dan makan siang 

13:00 - 14:00   Penyusunan rekomendasi untuk 

implementasi hasil pelatihan dalam kegiatan 

TK Al-Hikmah 
Table 8 kegiatan hari ke 7 senin 

Hari 8 (8 Oktober 2024 - Selasa): Penutupan dan Penyampaian Laporan Akhir 



08:00 - 10:00   Penyampaian laporan hasil kegiatan 

PMKM kepada pihak sekolah dan 

rekomendasi tindak lanjut 

10:00 - 12:00   Diskusi akhir, tanya jawab, dan penyerahan 

laporan 

12:00 - 13:00   Istirahat dan makan siang 

13:00 - 14:00   Penutupan kegiatan PMKM dan foto 

bersama 
Table 9 kegiatan hari ke 8 selasa 

 

Daftar kegiatan tidak terencana 

16 september 2024 12:20 – 13:00 Diskusi kegiatan pmkm 

17 september 2024 12:40 – 13.30 Diskusi kegiatan pmkm 

18 september 2024 13:00 – 14:00 Pengenalan lingkungan 

yayasan 

 2 jam Persiapan materi peletihan 

microsoft word dasar 

 2 jam Persiapan materi pelatihan 

microsoft word lanjutan 

 2 jam Persiapan materi microsoft 

excel dasar 

 2 jam Persiapan materi microsoft 

excel lanjutan 

 2 jam Persiapan materi microsoft 

power point dasar 

 2 jam Pembuatan laporan pelatihan 

microsoft word 

 2 jam Pembuatan laporan pelatihan 

microsoft excel 

 2 jam Pembuatan laporan pelatihan 

microsoft power point 
Table 10 daftar kegiatan tidak terencana 

 

Materi Pelatihan 

1. Pengenalan Microsoft Word 

• Apa itu Microsoft Word? Microsoft Word adalah aplikasi pengolah kata yang 

digunakan untuk membuat, mengedit, dan memformat dokumen teks. Sangat berguna 

untuk pekerjaan administratif seperti pembuatan surat, laporan, daftar, dan formulir. 

• Antarmuka Pengguna (User Interface) 



o Ribbon: Bagian atas yang berisi tab-tab seperti Home, Insert, Layout, dan 

lain-lain. 

o Toolbar Cepat: Di bagian kiri atas untuk akses cepat ke fungsi-fungsi penting 

seperti Save, Undo, dan Redo. 

o Area Dokumen: Tempat Anda mengetik dan mengedit teks. 

 

2. Membuat dan Mengatur Dokumen 

• Membuka Dokumen Baru 

o Klik File > New > Pilih Blank Document atau template yang sesuai. 

• Menyimpan Dokumen 

o Klik File > Save > Pilih lokasi penyimpanan dan beri nama file. 

o Save As untuk menyimpan dengan format lain seperti PDF. 

• Penataan Teks 

o Memilih Font: Pada tab Home, Anda bisa mengubah font, ukuran, dan warna 

teks. 

o Align Teks: Gunakan opsi Align Left, Center, Align Right, atau Justify untuk 

mengatur posisi teks. 

o Mengatur Spasi Baris: Klik Line and Paragraph Spacing untuk mengatur 

jarak antar baris teks. 

 

3. Pembuatan Template Dokumen Standar Sekolah 

• Langkah-langkah Membuat Surat Resmi: 

1. Header: Tuliskan tanggal, nama pengirim, dan alamat di bagian atas. 

2. Salam Pembuka: Gunakan sapaan formal seperti Yth. Bapak/Ibu. 

3. Isi Surat: Berikan keterangan jelas mengenai topik atau informasi yang ingin 

disampaikan. 



4. Penutup: Gunakan penutup formal seperti Hormat Saya, lalu nama dan 

jabatan. 

5. Menambahkan Tanda Tangan: Bisa ditambahkan melalui gambar (Insert > 

Picture) atau menggunakan fungsi Signature Line. 

 

4. Pembuatan Daftar dan Tabel 

• Daftar Poin (Bullets & Numbering) 

o Klik ikon Bullets atau Numbering di tab Home untuk membuat daftar. 

o Berguna untuk menyusun poin-poin agenda, instruksi, atau daftar tugas. 

• Membuat Tabel 

o Klik Insert > Table > Pilih ukuran tabel yang diinginkan. 

o Tabel sangat berguna untuk menyusun data seperti daftar hadir, jadwal, atau 

laporan keuangan. 

o Mengedit Tabel: Gunakan Table Tools untuk mengatur warna, border, atau 

menyatukan sel (merge). 

 

5. Menyisipkan Gambar, Tabel, dan Grafik 

• Menyisipkan Gambar 

o Klik Insert > Pictures untuk menyisipkan gambar dari komputer atau dari 

internet. 

o Atur ukuran dan posisi gambar dengan Wrap Text untuk menempatkan gambar 

sesuai kebutuhan. 

• Menyisipkan Grafik 

o Gunakan grafik untuk visualisasi data seperti laporan keuangan atau statistik. 

o Klik Insert > Chart, pilih jenis grafik yang sesuai (misal: bar chart, pie chart). 

 



6. Mengatur Layout dan Tampilan Cetak 

• Page Setup: Gunakan tab Layout untuk mengatur ukuran kertas, margin, orientasi 

halaman (portrait atau landscape). 

• Header dan Footer: Tambahkan judul atau nomor halaman di bagian atas atau bawah 

halaman melalui tab Insert > Header & Footer. 

• Print Preview: Klik File > Print untuk melihat tampilan dokumen sebelum dicetak. 

 

7. Tips dan Trik Microsoft Word untuk Pekerjaan Administratif 

• AutoCorrect: Fitur ini membantu memperbaiki kesalahan pengetikan secara otomatis. 

• Shortcuts Keyboard: 

Shortcut untuk Mengelola Dokumen 

o Ctrl + N: Membuat dokumen baru. 

o Ctrl + O: Membuka dokumen yang sudah ada. 

o Ctrl + S: Menyimpan dokumen. 

o Ctrl + P: Mencetak dokumen. 

o Ctrl + W: Menutup dokumen yang sedang dibuka. 

Shortcut untuk Mengedit Teks 

o Ctrl + C: Menyalin teks atau objek yang dipilih. 

o Ctrl + V: Menempelkan teks atau objek yang sudah disalin. 

o Ctrl + X: Memotong teks atau objek yang dipilih. 

o Ctrl + Z: Membatalkan perintah terakhir (Undo). 

o Ctrl + Y: Mengulangi perintah terakhir (Redo). 

o Ctrl + A: Memilih semua teks dalam dokumen. 

o Ctrl + F: Membuka kotak pencarian untuk menemukan teks tertentu. 

Shortcut untuk Pemformatan Teks 



o Ctrl + B: Membuat teks tebal (bold). 

o Ctrl + I: Membuat teks miring (italic). 

o Ctrl + U: Membuat teks bergaris bawah (underline). 

o Ctrl + E: Meratakan teks ke tengah. 

o Ctrl + L: Meratakan teks ke kiri. 

o Ctrl + R: Meratakan teks ke kanan. 

o Ctrl + J: Meratakan teks rata kanan dan kiri (justify). 

o Ctrl + Shift + >: Membesarkan ukuran font. 

o Ctrl + Shift + <: Mengecilkan ukuran font. 

o Shift + F3  : mengubah kapitalisasi dari sebuah kata ( rata huruf kapital, rata     

huruf kecil dan huruf depan kapital ) 

 

3.2  Hasil Pengabdian 

Hasil pelatihan yang diberikan kepada guru-guru TK Al-Hikmah menunjukkan 

perkembangan positif, meskipun belum sepenuhnya terimplementasi dalam kegiatan 

administratif sehari-hari. Salah satu faktor utama yang menghambat implementasi penuh 

adalah kebiasaan lama yang masih melekat pada para guru. Sebagian besar guru masih merasa 

lebih nyaman dengan metode tradisional yang telah mereka gunakan selama bertahun-tahun, 

sehingga transisi menuju penggunaan teknologi baru seperti Microsoft Word membutuhkan 

waktu lebih lama dari yang diharapkan. Kebiasaan ini tidak serta-merta hilang setelah pelatihan 

singkat, mengingat proses adaptasi terhadap teknologi baru memerlukan pembiasaan dan 

waktu yang cukup. 



 

 

 



Namun demikian, tanda-tanda positif mulai terlihat, di mana para guru secara bertahap 

mulai menerapkan keterampilan yang mereka peroleh dari pelatihan. Beberapa guru telah 

menunjukkan kemajuan dengan mulai menggunakan fitur-fitur dasar Microsoft Word dalam 

tugas administratif seperti penyusunan laporan perkembangan siswa dan surat kepada orang 

tua. Meskipun implementasi ini masih terbatas, ini adalah langkah awal yang menjanjikan 

menuju peningkatan efisiensi dalam pengelolaan dokumen di TK Al-Hikmah. Para guru yang 

lebih terbuka terhadap perubahan menunjukkan keinginan untuk terus belajar dan 

mempraktikkan kemampuan baru yang mereka pelajari. 

Faktor kebiasaan ini mempengaruhi kecepatan adopsi teknologi, namun tidak 

menghalangi proses peningkatan kompetensi para guru. Pelatihan lanjutan dan sesi 

pendampingan akan sangat membantu untuk memperkuat keterampilan yang telah dipelajari, 

sekaligus mendorong guru-guru lain yang masih ragu untuk mulai menerapkan teknologi 

tersebut dalam pekerjaan mereka. Dengan dukungan yang berkelanjutan, diharapkan semua 

guru pada akhirnya dapat mengatasi hambatan kebiasaan dan memanfaatkan Microsoft Word 

secara penuh untuk meningkatkan efisiensi kerja mereka. 

Secara keseluruhan, meskipun hasil pelatihan belum sepenuhnya terimplementasi, 

sudah ada perkembangan yang signifikan dalam penerapan teknologi di sekolah. Hal ini 

memberikan indikasi bahwa dengan pembinaan yang konsisten dan kesabaran, guru-guru 

TK Al-Hikmah akan semakin terbiasa dan mampu memaksimalkan penggunaan Microsoft 

Word dalam tugas administratif mereka, yang pada akhirnya akan meningkatkan 

produktivitas dan efektivitas kinerja di sekolah. 

Nama Penilaian 

Endang Tri Sukartini S.Pd menunjukkan pemahaman yang baik tentang materi 

pelatihan dan mampu menerapkan keterampilan yang 

diajarkan dengan cukup baik. Ada beberapa area yang 

masih memerlukan pengembangan, tetapi secara 

keseluruhan, performanya sangat memuaskan. 

Lian Sugiarsih S.Pd memiliki pemahaman dasar tentang materi, tetapi 

membutuhkan lebih banyak latihan untuk benar-benar 

menguasai dalam pengimplementasian. Ada potensi 

untuk berkembang, namun saat ini belum sepenuhnya 



memanfaatkan hasil pelatihan. 

Rokhimah S.Pd  memiliki penguasaan yang solid pada aspek-aspek 

dasar pelatihan. Meskipun telah memahami inti 

materi, ada beberapa hal teknis yang masih 

memerlukan perhatian. 

Insiati S.Pd sangat cepat belajar dan sudah menunjukkan 

kemampuan untuk menerapkan hasil pelatihan 

dengan sangat efektif. Ada kepercayaan diri dan 

kemandirian yang terlihat dalam pekerjaannya, 

menunjukkan penguasaan yang hampir sempurna 

Sumini S.Pd mengalami kesulitan dalam memahami beberapa 

bagian penting dari pelatihan dan membutuhkan lebih 

banyak bimbingan. Meskipun ada upaya yang cukup, 

hasil penguasaan belum maksimal 

 

  



BAB IV 

PENUTUP 

 

4.1  Kesimpulan 

Kesimpulannya, pelatihan penggunaan Microsoft Word di TK Al-Hikmah memberikan 

hasil yang positif meskipun belum sepenuhnya terimplementasi secara optimal. Faktor 

kebiasaan lama yang masih melekat pada sebagian guru menjadi tantangan utama dalam proses 

transisi menuju penggunaan teknologi baru. Namun, tanda-tanda kemajuan sudah mulai 

terlihat, di mana beberapa guru mulai menerapkan keterampilan yang mereka pelajari, terutama 

dalam tugas-tugas administratif seperti penyusunan laporan dan surat. Dengan pendampingan 

yang berkelanjutan serta pelatihan lanjutan, diharapkan para guru dapat semakin terbiasa 

menggunakan fitur-fitur Microsoft Word, sehingga efisiensi dan produktivitas dalam pekerjaan 

sehari-hari mereka akan meningkat secara signifikan 

 

4.2  Saran 

Sebagai saran, pendampingan berkelanjutan dan sesi pelatihan refresher perlu 

dilakukan untuk memperkuat pemahaman guru. Praktik langsung dalam tugas sehari-hari akan 

membantu mereka lebih terbiasa dengan Microsoft Word. Pendekatan bertahap, mulai dari fitur 

sederhana hingga kompleks. 

. 
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